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Sage MyAssistant version 23.1  
Release Highlights 

 
Sage 300 MyAssistant 23.1 provides customer-requested enhancements that can save time by proactively 

monitoring your business and automatically providing your team with needed information.  

 

MyAssistant 23.1 Highlights include:  

• A new option that exports information in Sage to CSV or Text files for use in other 

software.  Examples include: 

o Positive Pay files to upload to banks 

o Job Cost Transaction import files for overhead, burden, or other entries 

o Certified report and lien waiver tracking systems 

• Creating and sending spreadsheets in a password-protected PDF file 

• Consolidating and distribute information from multiple Sage data folders in a single spreadsheet  

• A more comprehensive Task Condition Preview with a count to ensure they’re getting the correct 

information  

• A quick way to view when each Task is scheduled to run from the main Task list 

• Additional quick-reference material to solve problems and learn more about MyAssistant 

• New ways to search for Sage information in the new English-like Condition option 

• An improved installation experience with reminders to update select MyAssistant components 

(Windows Services) 

• Easily transition to version 23.1 with your “Tasks” auto-upgraded to work with the new version 

• Fixed a variety of issues in the Spreadsheet Template Designer, Email Directories and Task Setup 

 

NOTE: MyAssistant 23.1 is compatible with Sage versions 20.5 or later.  You don’t need to upgrade your 

Sage software to upgrade to MyAssistant 23.1.  All of your existing MyAssistant Tasks will be automatically 

upgraded.  

Please contact your local Sage business parter or send a note using the “Need Help” button on the Help 

menu in MyAssistant for more information. 

 

 

The following pages outline MyAssistant 23.1 and 22.1’s enhancements.   



 

 

Create and Send CSV or Text Files  

MyAssistant 23.1 features the ability to easily create CSV (comma-separated values) and text files using 

MyAssistant Spreadsheet Templates. This allows for the creation of documents like Positive Pay files that 

are uploaded to banks, Transaction files that can be imported for things like overhead on JC Jobs, and 

more. 

These new “File Type” options are found when saving a new Spreadsheet Template on a MyAssistant 

Task. Updating an existing Spreadsheet Template to send something other than an Excel document can be 

done by performing the following: 

1. Open the MyAssistant Task 

2. Double-click the MyAssistant Spreadsheet Template in the Attachments section of the Email Step 

of Task Setup 

3. Click the “Page Layout” tab of the ribbon, then click the “Rename Workbook” button 

4. Change the File Type, then click “OK” to save changes 

 

 



 

 

Quick Report PDFs from Spreadsheet Templates 

You can now quickly generate and send PDF reports by using a Spreadsheet Template in MyAssistant 23.1. 

This lets you create and send reports to send each person a PDF of only their information. 

To send a PDF, choose “PDF” from the “File type” dropdown when saving a MyAssistant Spreadsheet 

Template.  

When choosing to send a PDF, you can also set a password to open the file. This is in addition to 

MyAssistant’s existing ability to password-protect Excel spreadsheets for opening and/or editing. 

 

Consolidate Information from Multiple Sage 

Data Folders  

With MyAssistant 23.1, a Task looking up information from multiple Sage data folders can create and send 

one spreadsheet with all the information. 

This is controlled by a check box that appears when saving a MyAssistant Spreadsheet Template (which 

MyAssistant uses to create spreadsheets): 

 



 

 

If the checkbox is checked, the information from each Sage data folder the Task monitors will be combined 

into a single spreadsheet. If the checkbox is not checked, a separate spreadsheet will be sent for each Sage 

data folder. 

 

Updated Condition Preview  

MyAssistant 23.1 includes an updated Preview in the Condition step of Task Setup, featuring a count of 

how many items met the criteria. This helps confirm that the Condition on a Task is finding only the correct 

information. 

 

Easily View Task Schedules 

A common request is to have one place to see when all MyAssistant Tasks are scheduled to run. With 

MyAssistant 23.1, the main MyAssistant window includes a column of each Task’s schedule by default. If 

upgrading from a previous version of MyAssistant, this can be seen by opening the software, clicking the 

“View” tab of the ribbon at the top of the window, then clicking “Restore Defaults”: 

 

This will reset the columns in the main Task list and add the “Schedule” column, which will show when all 

activated Tasks are scheduled to automatically run. 



 

 

Expanded Help Resources 

MyAssistant 23.1 features more than 15 new or updated Help topics that provide education on how to 

use MyAssistant, as well as answer questions & resolve issues clients may have.  

New & Updated Topics include: 

• Send a Spreadsheet Overview  

• Send Reports & Documents Overview 

• Spreadsheet Templates 

• Saving Copies of Spreadsheets 

• Saving Copies of Emailed Attachments 

• Attached Reports 

• Glossary 

• Troubleshooting Reports 

… and more. 

MyAssistant 23.1 also features a new Index and an improved Search in Help, as well as an updated User 

Guide. All these changes enable users to quickly find the correct information based on their needs. 

New Ways to Search for Sage Information 

The new, English-like Task Conditions introduced in MyAssistant 22.1 have been enhanced in version 23.1. 

Updates include adding new ways to search for information, like checking for dates in Sage that match 

yesterday’s date. Other updates include changing how searching for a date that’s in the next month or last 

month will update as the current date changes. 

 

Reminders When Upgrading MyAssistant 

When upgrading to MyAssistant 23.1 from a prior version, reminders will appear if components used to 

run Tasks and send emails (i.e. Windows Services) need to be updated after the upgrade is completed. 

These reminders will only appear in situations where the components need to be updated. 

 



 

 

Auto-Upgrade Existing “Tasks” 

If upgrading to MyAssistant 23.1 from a prior version, all activated Tasks from the prior version will be 

automatically upgraded. This ensures all Tasks that were running prior to the upgrade will continue to 

work as designed. 

  

Additional Software Updates 

• Compatible with Sage 300 CRE version 20.5 and later, meaning Sage does not need to be 

upgraded to use MyAssistant 23.1 

• Resolved issue where Sage fields removed from a Spreadsheet Template were still being included 

• Added and updated various tooltips 

• Fixed situation where new Sage folders added on the MyAssistant Server couldn’t be added to a 

MyAssistant workstation 

• Updated MyAssistant install files to ensure the correct program is run to install the software 

• Resolved issue with some MyAssistant Formulas finding the wrong result types (e.g. looking for 

dates instead of numbers or text) 

• Fixed issue where users had to click out of a field in the Condition to save the value 

  



 

 

 

Sage MyAssistant version 22.1  

Release Highlights 

 
Sage 300 MyAssistant 22.1 provides many customer-requested enhancements that help you do more. 

Customers asked for easier ways to:  

• Automate more workflows like sending employee or vendor payment notices, lien waivers, 

Customer Statements, etc.   

• Create simple alerts like expiration dates, missing information or incorrect data entry 

• Send Sage information in spreadsheets  

• Get help when working in MyAssistant 

• Learn how others are using MyAssistant 

 

 MyAssistant 22.1 Enhancements 

• A new MyAssistant “Task” setup process 

• Specify what you want to find in Sage with new English-like “Conditions”  

• 400+ preconfigured “Conditions” converted to English-like setup for easy customization  

• Option to save emailed spreadsheets to job, vendor, etc. specific folders   

• Automatically name Tasks based on the Email Subject   

• New Help instructions and information icons 

• 200+ new Formulas that report on Sage information   

• Additional MyAssistant Server settings accessible from the Designer  

• Solve problems quicker using common solutions in a new System Log  

• Upgraded software to Windows 11 look and feel  

• New “MyAssistant Ideas” service  

• Compatible with Sage versions 20.1 and later   

• Enhance software performance by automatically removing closed notifications   

 

The following pages outline MyAssistant 22.1’s enhancements and detail its new, simplified workflows. 

  



 

 

Simplified “Task” Setup 

The following outlines the simplified Task setup process for sending notifications / alerts, spreadsheets 

and generate reports, statements and documents. 

Sending a List of Notifications or Alerts  

Setting up Tasks to automatically send a list notifications like past due invoices, Jobs recently set up, 

Vendors with expiring insurance, or Employees missing information is a few steps. For example, let’s 

automatically send a list of cash receipts received: 

1. Start by opening a new Task, then picking what you want to send: Select "List of Notifications”, then 

choose what you want to send a list of: 

 

2. Select a pre-built “Condition” that creates a list given specified criteria, or choose to create a “New 

Condition” 

3. Create or customize the Condition’s with new, English-like statements. For example, 

a. Change the first row by selecting a Sage field (e.g. AR Customer Status), an operand (equals) 

and a value to test against.  

 



 

 

b. Add lines to the Condition with the “Add Row” button 

 

c. Edit additional rows to dial in exactly what you want 

d. Click “Preview” to confirm the information the Condition found is what you want 

See page 11 for more information on the new Condition functionality. 

 

4. Schedule when the Task should automatically run. 

5. In the Email step: Click & drag the Sage information that you want included in your Notification list 

from the list on the right to the bottom-middle section, then add recipients and an Email subject 

 

6. Finish Task Setup and send the email(s) 



 

 

Sending a Spreadsheet 

While many customers already use MyAssistant to send spreadsheets, MyAssistant 22.1 features an 

easier way to send things like AR Aging, AP Invoice Register and Cost to Completion data in an Excel 

format.  For example, to automatically send someone a spreadsheet of jobs that are over budget:  

1. Start by opening a new Task, then picking what you want to send: Select "Spreadsheet”, then 

choose what you want to send a Spreadsheet of: 

 

2. Select a pre-built “Condition” that creates a spreadsheet given specified criteria, or choose to create 

a “New Condition”  

3. Create or customize the Condition’s with new, English-like statements. For example, 

a. Change the first row by selecting a Sage field (e.g. JC Job Status), an operand (equals) and a 

value to test against.  

 

 



 

 

b. Add lines to the Condition with the “Add Row” button 

 

c. Edit additional rows to dial in exactly what you want 

d. Click “Preview” to confirm the information the Condition found is what you want 

See page 11 for more information on the new Condition functionality. 

 

4. Schedule when the Task should automatically run. 

  



 

 

5. In the Email step: Click & drag the Sage information you want in your spreadsheet from the list on 

the right to the bottom-middle section. Arrange in the order you want, then click the “Spreadsheet 

Template” button in the ribbon and select “Use Notification List”: 

 

This will automatically create a spreadsheet template (what MyAssistant will use to build the 

spreadsheet) 

6. Adjust the column widths in the new window that opens, preview the spreadsheet to confirm you’re 

getting what you want, then click “Save & Close” in the ribbon: 

 

7. Add recipients and a Subject, then complete Task Setup. 



 

 

Sending Reports 

A common customer request is to automatically send reports. Using MyAssistant to send Sage reports 

where everyone gets the same information consists of the following: 

1. Open a new Task and select “Report attached as a PDF”:  

 

2. Schedule when the Task should automatically run. 

3. In the Email Step: Click the “Sage Report” button and select your report from the window that opens 

4. Fill out any report prompts in the Window that opens, then click OK 

 

5. Add recipients & a Subject, then finish Task Setup 

 

  



 

 

Sending Each Person Reports or Documents with Just their Information 

Many companies use MyAssistant to send people their reports or documents with only their 

information. Common examples include sending Employee pay statements, Customer statements, or 

electronic payment notifications to Vendors. 

For example, creating a Task to send each employee their pay stubs now consists of the following: 

1. Open a new Task, then choose what you want to send: Select "Each person their reports or 

documents”, then choose the Sage information to use for deciding who does & doesn’t get an email 

(i.e. a “mailing list”):  

 

2. Select a pre-built “Condition” that creates a list given specified criteria, or choose to create a “New 

Condition” 

3. Create or customize the Condition’s with new, English-like statements. For example, 

a. Change the first row by selecting a Sage field (e.g. PR Check Period End Date), an operand (in 

the last specified days) and a value to test against.  

 



 

 

b. Add lines to the Condition with the “Add Row” button 

 

c. Edit additional rows to dial in exactly what you want 

d. Click “Preview” to confirm the information the Condition found is what you want 

See page 11 for more information on the new Condition functionality. 

 

4. Schedule when the Task should automatically run. 

5. In the Email step: click “Sage Report” or “Crystal Report” and select the report that includes the 

prompts needed to filter the content by recipient (e.g. prompt for Project Manager on Cost Reports, 

Employee ID on pay statements, or Customer ID prompt on customer statements).  

 



 

 

6. Update the prompts in the window that opens to use values from Sage fields to filter the content of 

the report: 

 

7. Click “Email Directory” in the ribbon and select the Email Directory that will look up an email address 

for each item found by the Condition 

 

8. Finish Task Setup & send emails 



 

 

Find Information in Sage with New, English-Like Conditions 
Making it easier to specify what you’d like MyAssistant to find was a top Customers request. To address 

this, Conditions were redesigned in MyAssistant 22.1 to use simple, English-like statements like: 

o Checking for a date “in the last specified days” or “in the next 30 days” 

o Selecting Jobs numbers that “Begin with”,  “End with” or “Contains” certain characters 

o Checking for amounts over a specified number in a range of numbers 

o Looking up Sage information like sums, counts or calculations using MyAssistant Formulas  

 

Creating Conditions now consists of adding and changing rows of easy-to-understand text. 

 

This could include: 

Selecting/changing the Sage field you want to check: 

 



 

 

Choosing the operand for what you want to do: 

 

The real power are the 75 “Operands”, which will change based on what you’re conditioning on (i.e. a 

date, number or text) 

Text Operands  Number Operands 

   

   

   

   

   

   

   

   

   

   

   

   

   

   

  



 

 

Date Operands 

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

 

Entering a value or choose a Sage field or MyAssistant formula to check against: 

 



 

 

Previewing the Condition at any time to confirm you’re getting the right information: 

 

 

Preconfigured Conditions converted to English-like setup 

Sage Customers often start with the “prebuilt” Tasks to learn about MyAssistant. However, they would 

like customize them to get exactly what they wanted. To help with this, more than 400 Conditions that 

come with the MyAssistant have been converted to use the new, English-like statements. This lets you 

easily customize existing Conditions to use on your Tasks and get exactly the information you’re looking 

for, including almost all prebuilt Tasks that are pre-installed with MyAssistant.  

 

Save Emailed Spreadsheets to “Smart” Folders 

Just like with reports attached to Tasks, Sage customers asked to save copies of spreadsheets they send 

with MyAssistant. In MyAssistant 22.1, emailed spreadsheets can be saved to a specified folder. 

MyAssistant can also automatically save using “smart” folders that are based on values in Sage (e.g. 

Customer, Vendor, Job, or Project Manager Name). For example: you could send each Project Manager a 

weekly cost spreadsheet for each of their Jobs, then have MyAssistant automatically create a folder 

named after the Project Manager with a copy of each spreadsheet.  



 

 

New System Log 

MyAssistant 22.1 features a System Log in the MyAssistant Designer that identifies and explains (in non-

technical terms) what happened if an error occurs:  

 

This helps you solve common issues yourself with step-by-step instructions. If someone else needs to 

review the log, you can also export a copy to Excel. 

 

New Help, additional resources, tooltips and information icons 

To help Sage customers understand what’s changed in MyAssistant and provide more information 

overall, MyAssistant 22.1 includes several resources: 

MyAssistant’s "Help” has been completely rewritten to align with the new software. MyAssistant Help 

can be accessed at any time from the File menu, or by clicking the “?” in the top-right of the window. 

A new User Guide is available in the Windows Start menu and the MyAssistant File > Help menu. 

Also, new software tooltips and information icons have been added throughout MyAssistant. This 

provides more contextual information around the specific things you’re looking at. 

  



 

 

General Software Improvements 

▪ Added 200+ MyAssistant Formulas that report on Sage information and can be used in Conditions, 

emails, spreadsheets, report prompts and more. Please see the addendum at the end of the 

document to see all the new MyAssistant formulas added to the software 

▪ New Tasks can be automatically named based on the Subject line in the Email step 

▪ Additional MyAssistant Server settings are now accessible from the MyAssistant Designer 

▪ Enhanced MyAssistant’s performance by automatically removing old Task results (i.e. 

“Notifications”) that no longer meet the Task criteria 

▪ Created new service that gives you the option to receive new ideas on how to use MyAssistant 

▪ Compatible with Sage versions 20.1 and later 


